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ABSTRAK

Putra-Putri Altar (PPA) adalah salah satu bentuk panggilan seorang awam khususnya
remagja untuk dapat melayani Tuhan dengan baik. PPA diharapkan dapat melaksanakan
tugasnya dengan baik sehingga perayaan Ekaristi dapat berjalan dengan lancar dan khidmat.
Dengan menjadi PPA, seorang awam/remagja diharapkan dapat menjiwai semangat
pelayanannya, baik ketika bertugas dalam perayaan Ekaristi, maupun dalam kehidupan sehari-
hari. Sehingga akan menghasilkan buah-buah iman di dalam kepribadian seorang PPA, dalam
bentuk sikap rendah hati, mandiri, disiplin, bertanggung jawab, kepemimpinan dan mampu
bekerja sama dengan baik.

Bidang Liturgi Gergja Santa Perawan Maria dari Gunung Karmel (SPMGK) atau yang
dikenal dengan Gergja ljen memiliki beberapa program untuk melakukan pendampingan dan
pembinaan PPA antaralain melalui kegiatan liturgi dan non liturgi baik secarainternal maupun
eksternal. Program kerja tersebut disusun dan dilakukan dengan tujuan agar PPA : 1) mampu
menjalankan tugas pelayanannya dengan baik, 2) memperdalam iman kristiani, 3) memiliki
nilai kerendahan hati, kemandirian, kedisiplinan, kepemimpinan dan mampu bekerja sama
dengan baik. Selain itu PPA didampingi dan dibina untuk mampu mengelola organisasi PPA
dengan baik dan mandiri. Bentuk pengelolaan secara mandiri tersebut antara lain, mereka
dilatih untuk mampu : 1) mendokumentasikan kegiatan-kegiatan PPA dalam bentuk foto dan
video 2) membuat desain untuk keperluan publikasi kegiatan, 3) mempublikasikan kegiatan
dengan baik. Namun bidang Liturgi Gereja SPMGK memiliki keterbatasan sumber daya
manusia yang memiliki kompetensi sesuai dengan materi pendampingan yang diharapkan.
Kegiatan yang dimaksud antara lain: pelatihan pemanfaatan teknologi informasi, desain logo,
editing foto dan video, dan lain-lain.

Kegiatan IbM yang akan dilakukan adalah memberikan pelatihan kemampuan desain
menggunakan software Corel Draw dan desain bangunan menggunakan Autodesk Revit
Building. Hasil kegiatan ini diharapkan mampu memberikan kontribusi secara khususterhadap
peningkatan kemampuan PPA di dalan mendesain dan secara umum terhadap partisipas
UKWK di dalam masyarakat.

Berdasarkan pelaksanaan pelatihan keterampilan dan dari hasil evaluasi, Peserta dapat
memahami materi yang disampaikan dengan baik dan dapat mengaplikasikan dalam project
kecil dengan baik, hasil project kecil dengan pembuatan logo, pembuatan denah sederhana dan
cover buku. Hasil evaluasi dari pelatihan juga dapat untuk mereferensikan bagi Pendamping
dan Pembina PPA sebagai tindak lanjut kegiatan PPA di Gergja Paroki SPMGK atau Gergja
ljen Maang yaitu memulai mengelola kegiatan yang berhubungan dengan publikasi
dokumentasi dan pemanfaatan teknologi informasi.

Kata kunci : Desain grafis, desain bangunan, software Corel Draw, Autodesk Revit.
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RINGKASAN

Putra-Putri Altar (PPA) adalah salah satu bentuk panggilan seorang awam khususnya
remga untuk dapat melayani Tuhan dengan baik. PPA diharapkan dapat melaksanakan
tugasnya dengan baik sehingga perayaan Ekaristi dapat berjalan dengan lancar dan khidmat.
Dengan menjadi PPA, seorang awam/remagja diharapkan dapat menjiwa semangat
pelayanannya, baik ketika bertugas dalam perayaan Ekaristi, maupun dalam kehidupan sehari-
hari. Sehingga akan menghasilkan buah-buah iman di dalam kepribadian seorang PPA, dalam
bentuk sikap rendah hati, mandiri, disiplin, bertanggung jawab, kepemimpinan dan mampu
bekerja sama dengan baik.

Bidang Liturgi Gergja Santa Perawan Maria dari Gunung Karmel (SPMGK) atau yang
dikenal dengan Gergja Ijen memiliki beberapa program untuk melakukan pendampingan dan
pembinaan PPA antaralain melalui kegiatan liturgi dan non liturgi baik secarainternal maupun
eksternal. Program kerja tersebut disusun dan dilakukan dengan tujuan agar PPA : 1) mampu
menjalankan tugas pelayanannya dengan baik, 2) memperdalam iman kristiani, 3) memiliki
nilai kerendahan hati, kemandirian, kedisiplinan, kepemimpinan dan mampu bekerja sama
dengan baik. Selain itu PPA didampingi dan dibina untuk mampu mengelola organisasi PPA
dengan baik dan mandiri. Bentuk pengelolaan secara mandiri tersebut antara lain, mereka
dilatih untuk mampu : 1) mendokumentasikan kegiatan-kegiatan PPA dalam bentuk foto dan
video 2) membuat desain untuk keperluan publikas kegiatan, 3) mempublikasikan kegiatan
dengan baik. Namun bidang Liturgi Gereja SPMGK memiliki keterbatasan sumber daya
manusia yang memiliki kompetensi sesuai dengan materi pendampingan yang diharapkan.
Kegiatan yang dimaksud antara lain: pelatihan pemanfaatan teknologi informasi, desain logo,
editing foto dan video, dan lain-lain.

Kegiatan IbM yang akan dilakukan adalah memberikan pelatihan kemampuan desain
menggunakan software Corel Draw dan desain bangunan menggunakan Autodesk Revit
Building. Hasil kegiatan ini diharapkan mampu memberikan kontribusi secara khusus terhadap
peningkatan kemampuan PPA di dalam mendesain dan secara umum terhadap partisipas
UKWK di dalam masyarakat.

Berdasarkan pelaksanaan pelatihan keterampilan dan dari hasil evaluasi, Peserta dapat
memahami materi yang disampaikan dengan baik dan dapat mengaplikasikan dalam project
kecil dengan baik, hasil project kecil dengan pembuatan logo, pembuatan denah sederhana dan
cover buku. Hasil evaluasi dari pelatihan juga dapat untuk mereferensikan bagi Pendamping
dan Pembina PPA sebagai tindak lanjut kegiatan PPA di Gergja Paroki SPMGK atau Gergja
ljen Maang yaitu memulai mengelola kegiatan yang berhubungan dengan publikasi
dokumentasi dan pemanfaatan teknologi informasi.

Kata kunci : Desain grafis, desain bangunan, software Corel Draw, Autodesk Revit..

LAPORAN PROGRAM IbM UKWK - 2018



BAB |
PENDAHULUAN
[.1 ANALISISSITUAS

a. Letak Geografisdan Administrasi

GergjaParoki Santa Perawan Mariadari Gunung Karmel Secarageografis berada di pusat
kota Malang, tepatnya di alamat Jalan Buring no. 60 Kelurahan Oro-oro Dowo Malang. Posis
bangunan Geregja berada tepat di sudut jalan yang berdekatan dengan Jalan ljen, maka juga
disebut Gergja ljen.

.

Gambar 1-1 Gereja Paroki ta Perawan Maria dari Gunung Karmel
( Gergaljen Maang)

GergjaParoki Santa Perawan Mariadari Gunung Karmel (SPMGK) tau Geregjaljen terdiri
dari 11 Wilayah dan 31 Lingkungan. Dalam kepengurusannya Gereja ljen memiliki berbagai
bidang, salah satunya adalah Bidang Liturgi. Bidang Liturgi mempunyai tanggungjawab yaitu
diantaranya adalah menjadi pembimbing dan pengembangan Misdinar atau Putra-Putri Altar
(PPA). Remaja Katolik yang terdiri dari remaja Katolik biasa antara usia 12 tahun (kelas 1
SMP) hingga usia maksimum 21 tahun (kelas 3 SMA).
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Unika Widya Karya sebagai satu-satunya Universitas Katolik di wilayah Keuskupan
Malang diharapkan mampu memberikan kontribusi positif kepada masyarakat, khususnya
kepada Gergja dan Keuskupan Malang, sebagai bentuk pelaksanaan Pengabdian Masyarakat
yang merupakan bagian dari Tri Dharma Perguruan Tinggi.

b. PutraPutri Altar (PPA)

PPA atau biasa disebut Misdinar (Belanda: misdieenarr; Inggris: altar boys; Latin: akolit)
adalah suatu posisi pelayanan Gergjawi yang diberikan kepada kaum awam dengan tugas
utama untuk bersama-sama dengan imam mempersiapkan Ekaristi yang layak kepada Tuhan.
PPA atau juga pelayan altar turut membantu imam baik dalam mempersiapkan materi-materi

Ekaristi, mendupa umat, memberikan tanda konsekrasi, menambah makna liturgi Misa.

Gambar 1-2 Romo dan Misdinar Gergja ljen Malang
(Sumber: Dokumentasi PPA Geregjaljen, 2017)

PPA adalah salah satu bentuk panggilan seorang awam khususnya remaja untuk dapat
melayani Tuhan dengan baik. PPA diharapkan dapat melaksanakan tugasnya dengan baik
sehingga perayaan Ekaristi dapat berjalan dengan lancar dan khidmat. Dengan menjadi PPA,
seorang awam/remaj adiharapkan dapat menjiwai semangat pelayanannya, baik ketikabertugas
dalam perayaan Ekaristi, maupun dalam kehidupan sehari-hari. Sehingga akan menghasilkan
buah-buah iman di dalam kepribadian seorang PPA, dalam bentuk sikap rendah hati, mandiri,

disiplin, bertanggung jawab, kepemimpinan dan mampu bekerja sama dengan baik.

LAPORAN PROGRAM IbM UKWK - 2018
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c. Pembinaan Putra Putri Altar

Bidang Liturgi Gergja SPMGK memiliki beberapa program untuk melakukan
pendampingan dan pembinaan PPA antara lain melalui kegiatan liturgi dan non liturgi baik
secarainternal maupun eksternal. Program kerja tersebut disusun dan dilakukan dengan tujuan
agar PPA: 1) mampu menjalankan tugas pelayanannya dengan baik, 2) memperdalam iman
kristiani, 3) memiliki nilai kerendahan hati, kemandirian, kedisiplinan, kepemimpinan dan
mampu bekerja sama dengan baik. Program kegiatan yang dilakukan antara lain:
1) Kegiatan Liturgi :

a) Doarutin bersama

b) Rekoleksi

c) Latihan rutin
2) Kegiatan Non Liturgi

a) Olahraga

b) Rekreas/ outbond

c) Pertemuan antar PPA se Keuskupan Malang

d) Jambore PPA Dakenat Malang

e) Terlibat di dalam lomba antar PPA (lomba desain logo, dsb)

f) Pelatihan pemanfaatan teknologi informasi/ fotografi/ video

Selain itu PPA didampingi dan dibina untuk mampu mengelola organisasi PPA dengan
baik dan mandiri. Bentuk pengel olaan secaramandiri tersebut antaralain, merekadilatih untuk
mampu: 1) mendokumentasikan kegiatan-kegiatan PPA dalam bentuk foto dan video 2)
membuat desain untuk keperluan publikasi kegiatan, 3) mempublikasikan kegiatan dengan
baik, dll.

f b I.) -
Gambar 1-3 Jambore Putra-Putri Altar se-Dekenat Kota Malang
(Sumber: Dokumentasi PPA Gergjaljen, 2017)

LAPORAN PROGRAM IbM UKWK - 2018
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.2 PERMASALAHAN

a. Permasalahan berdasarkan Analisa Keadaan Dar ur at

Berdasarkan informasi yang diperoleh dari Pembina PPA Gergja SPMGK, Daam
melaksanakan program kegiatan pendampingan dan pembinaan, Bidang Liturgi Gerga
SPMGK bekerja sama dengan beberapa pihak yang memiliki kompetensi untuk memberikan
materi/ kegiatan sesuai dengan yang diharapkan. Hal ini dilakukan, karenaketerbatasan sumber
daya manusia yang memiliki kompetensi sesuai dengan materi pendampingan yang
diharapkan. Kegiatan yang dimaksud antara lain: pelatihan pemanfaatan teknologi informas,
desain logo, editing foto dan video, dan lain-lain.

Permasalahan lainnya yaitu dengan perkembangan teknologi, PPA perlu diberikan
keterampilan desain yang berhubungan bangunan atau gedung dengan menggunakan software
Autodesk Revit. Autodesk Revit merupakan program yang sangat tepat dibutuhkan dalam

merancang bangunan tiga dimensi secara cepat.

b. Kemampuan keterampilan PPA

PPA Geregja SPMGK, terdiri dari remgja Katolik antara usia 12 tahun (kelas 1 SMP)
hingga usia maksimum 21 tahun (kelas 3 SMA). Secara umum, mereka telah memiliki
kemampuan yang baik untuk mengoperasikan komputer dan menjalankan software aplikas
dasar seperti MS Word, MS Excel, dil. Namun masih kurang di dalam penguasaan software
untuk membuat desain grafis dan multimedia, seperti Corel Draw, Adobe Photshop, dan
software aplikai khusus lain yang mendukung kinerja mereka di dalam mengelola kegiatan

PPA secara mandiri maupun terlibat di dalam kegiatan eksternal.

LAPORAN PROGRAM IbM UKWK - 2018



BAB ||
SOLUSI dan TARGET LUARAN

1.1 SOLUsS

Berdasarkan permasalahan yang telah teridentifikasi, maka dapat disampaikan aternatif
solusi yang ditawarkan yaitu: Perlunya pelatihan keterampilan untuk melakukan desain grafis
dengan bantuan software Corel Draw dan pengenal an softwar e desain bangunan menggunakan
Autodesk Revit Building. Pelatihan dan pendampingan ini diusulkan menjadi Program
Pengabdian kepada Masyarakat (Abdimas) pada tahun 2017-2018. Selain itu, kegiatan ini
merupakan salah satu bentuk kontribusi nyata UKWK khususnya kepada gereja dan
masyarakat.

1.2 TARGET LUARAN
Target luaran dari program abdimas ini adal ah:

a. Peningkatan pemahaman dan keterampilan PPA Gergja SPMGK di dalam mendesain
grafis dengan menggunakan program Corel DRAW dan desain bangunan dengan software
Autodesk Revit.

b. Tersusunnya modul pelatihan dengan software Corel DRAW dan desain bangunan dengan
software Autodesk Revit

c. Hasil kegiatan ini dapat dipublikasikan di jurnal ilmiah nasional
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BAB I11
METODE PELAKSANAAN

M etode pelaksanaan yang akan dilakukan oleh Tim Pelaksana adal ah:
I11.1 DISKUSI DAN PENYAMAAN PERSEPS
Diskusi antaratim pelaksana dengan Pembina PPA, untuk:

a

b
c
d.
e

Mengetahui kebutuhan materi yang diperlukan bagi PPA

. Mengetahui kondisi awal kemampuan PPA

Mengetahui sumber daya yang dimiliki (hardware, software, ruang, dsb)
Mengetahui jumlah peserta yang akan mengikuti pelatihan
Mendikusikan waktu pelaksanaan dan target yang harus tercapai

[11.2 PEMBUATAN MODUL DAN RENCANA JADWAL KEGIATAN
Pembuatan Modul terdiri dari modul modul pelatihan dengan software CorelDRAW dan

desain bangunan dengan software Autodesk Revit. Kegiatan direncanakan akan dilaksanakan
setelah Paskah 2018 atau bulan Mei 2018 selama 2 (dua) minggu bertempat di Laboratorium
Komputer D 111 Managemen Informatika UKWK.

1.3 PELAKSANAAN PELATIHAN GAMBAR TEKNIK

a

Sebelum pelatihan dilaksanakan, setiap peserta diwajibkan mengisi pre-test tentang
pengetahuan Corel Draw dan Autodesk Revit.

Materi pelatihan adalah pembuatan desain grafis sederhana dengan bantuan software
Corel DRAW dan pembuatan desain bangunan sederhana dengan bantuan software
Autodesk Revit.

Kebutuhan alat yang diperlukan adalah: LCD Proyektor, Laptop/komputer, dan
whiteboard.

Seorang instruktur dari Tim Pelaksana akan dibantu oleh 2 (dua) orang mahasiswa
yang menguasai Corel Draw dan Autodesk Revit untuk membantu kelancaran proses
pel atihan.

Setelah pelatihan pelatihan dengan software CorelDRAW dan desain bangunan
dengan software Autodesk Revit selesal, setiap peserta akan dilakukan post-test
tentang pengetahuan mendesain grafis dengan software CorelDRAW dan desain

bangunan dengan software Autodesk Revit.
LAPORAN PROGRAM IbM UKWK - 2018
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Di dalam pelatihan ini diperlukan partisipasi mitra dalam bentuk:
a Bersedia berdiskusi dan berpartisipas aktif bersama tim pelaksana dalam
pel aksanaan program pelatihan dan pendampingan.

b. Menyiapkan peserta pelatihan dan bersedia bekerjasama secara berkelanjutan

LAPORAN PROGRAM IbM UKWK - 2018



BAB IV
HASIL DAN PEMBAHASAN

IV.1 PELAKSANAAN PELATIHAN

a. Waktu dan Tempat
Pelaksanaan pelatihan dengan materi Corel Draw dan desain bangunan dengan
menggunakan Autodesk Revit Building dilaksanakan di Laboratorium Komputer DIII-
Mangemen Informatika Fakultas Teknik Universitas Katolik Widya Karya (UKWK)
Malang. Pelatihan dilaksanakan pada hari Jumat dan Sabtu, tanggal 25-26 Mei 2018. Pukul
15.00 - 20.00 WIB.

b. Peserta
Peserta pelatihan pada kegiatan pengabdian masyarakat adalah Putra-Putri Altar Gergja
Paroki SPMGK atau Gergja ljen Malang kurang lebih 9 orang peserta. Peserta pelatihan
tidak semua anggota dari PPA Gerga ljen Malang, akan tetapi peserta dari PPA Gergja
Ijen Malang dilakukan proses seleksi oleh Pendamping dan Pembina Geregja ljen Malang.
Proses seleksi ini dilakukan dengan tujuan antara lain: 1) Peserta hasil seleksi adalah
peserta yang telah terbiasa menggunakan perangkat komputer, sehingga diharapkan dapat
mengikuti materi yang akan diberikan oleh tim abdimas UKWK. 2) Peserta hasil seleksi
yang diikutkan pelatihan akan dijadikan pengurus kegiatan PPA Gergja ljen Malang
terutama yang bertugas untuk pengolahan dokumentasi, publikasi, dan penerapan

teknologi informasi.

J" | _.‘" i Ay B
Gambar IV-1 Misdinar Gerglaljen Malang

(Sumber: Dokumentasi Pribadi)
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c. Pelaksanaan kegiatan

Pelatihan dilaksanakan dengan diawali oleh materi | tentang Software Corel Draw.
Adapun detail materi | yaitu:

1) Definisi dan penggunaan dasar Software Corel Draw.

2) Desain grafik berbasis Bitmap dan Vektor

(a) (b)
Gambar V-2 (a) Grafik Berbasis Bitmap, (b) Grafik Berbasis Vektor
(Sumber: Dokumentasi Pribadi)

3) Penggunaan bagian-bagian pada interface software Corel Draw.

4) Create object, perataan objek, dan pemberian efek khusus pada objek.

5) Pengerjaan Project kecil; pembuatan logo, pembuatan cover dan penempatan text pada
lembar layout.

Penyampaian materi | dilanjutkan dengan tanyajawab bersama peserta pel atihan, sebagian
besar pertanyaan yang digjukan adalah terkait dengan kreasi pembuatan dan penataan pada
desain yang dibuat, serta troubleshooting dari permasalahan yang ditemukan. Penyampaian
materi | dilaksanakan mulai pukul 15.00 — 17.00 WIB. Pukul 17.00 — 18.00 WIB pelatihan di
istirahatkan dan makan malam, sambil dilakukan persiapan untuk penyampaian materi II.
Materi Il dimulai pada pukul 18.00 hingga pukul 20.00 WIB. Materi |l yaitu software Autodesk
Revit Building sebagai software bantu di dalam pembuatan gambar teknik untuk aplikas
bangunan. Peserta digjak untuk langsung mencoba membuat gambar denah sederhana dan
pemberian notasi-notasinya seperti nama ruang, dimensi, dan setting tampilan. Selainitu, juga
disampaikan keuntungan menggunakan Autodesk Revit Building dibandingkan dengan gambar
manual atau dengan software lain, salah satunya adalah kemampuan bentuk denah dan
bangunan 3 Dimensi secara cepat. Materi | dan 11 diberikan ke seluruh peserta dalam hardcopy.
Acara diakhiri dengan penyerahan sertifikat ke setiap peserta pelatihan kemudian dilanjutkan
dengan diskusi dan membahas evaluasi dari pelaksanaan pelatihan terutama peningkatan

kemampuan dari setiap peserta.
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Adapun foto-foto kegiatan pengabdian masyarakat dalam pelatihan Corel Draw dan
Autodesk Revit Building seperti berikut.

Gambar 1V-3 Regristasi Peserta Pelatihan
(Sumber: Dokumentasi Pribadi)

Gambar 1V-4 Sambutan dari Rm. Albertus H.. O.Carm.M_.A. Sebelum Pelatihan Dimulai
(Sumber: Dokumentasi Pribadi)

Gambar IV-5 Penyampaian Materi Pelatihan
(Sumber: Dokumentasi Pribadi)
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Gambar V-6 Proses Pendampingan dan Diskusi dengan Peserta Pelatihan
(Sumber: Dokumentasi Pribadi)

— S —

Gambar 1V-7 Foto Bersama Peserta Pelatihan
(Sumber: Dokumentasi Pribadi)

d. PEMBAHASAN
1 Pelatihan
Kegiatan pelatihan Corel Draw dan Autodesk Revit Building dapat terlaksana dengan
baik dan materi-materi yang disampaikan dapat diaplikasikan serta dikreasikan. Hal ini
ditunjukkan dan dapat dibuktikan oleh masing-masing peserta:

a) Pada saat diberikan materi dasar hingga penggunaan program Corel Draw dan
Autodesk Revit Building dapat mengikuti dan memahami materi dengan
mengaplikasikan pada soal latihan dasar yang diberikan oleh tim pelaksana. Latihan
dasar tersebut salah satunya yaitu membuat objek sederhana dan menata teks dalam
bentuk logo dengan contoh hasil dari salah satu peserta seperti gambar dibawah ini.

LAPORAN PROGRAM IbM UKWK - 2018



19

Gambar 1V-8 Hasil latihan dari peserta pelatihan

b) Mengaplikasikan program pelatihan yang telah disampaikan ke dalam sebuah project
kecil seperti untuk program Corel Draw membuat cover buku dan program Autodesk
Revit Building membuat bangunan tiga dimens satu lantai.

& Kusnimy RaLas

@) (b)
Gambar 1V-9 (a) Project membuat Cover Buku, (b) Bangunan 1 (satu) lantai

2 Modul Pelatihan

Pembuatan modul oleh tim pelaksana bertujuan supaya pada proses pelatihan peserta
dapat mudah mengikuti materi-materi yang diberikan dengan mudah sehingga
pelaksanaan pelatihan dapat berjalan secara efektif. Selain itu modul pelatihan berguna
bagi peserta saat mengerjakan dan memperdal am kemampuannya dalam mengaplikasikan
pada suatu kasus yang diberikan oleh tim pelaksana. Modul yang telah dibuat oileh tim
pel aksanaada 2 (dua) modul yaitu modul Corel Draw dan modul Autodesk Revit Building.

MOTHIT
MODUL Sk 4V T
Cor DRAY

(@ (b)
Gambar 1V-10 (&) Modul | Corel Draw, (b) Modul 11 Autodesk Revit Building
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BAB V
PENUTUP

V.1 KESIMPULAN
Dari hasil pelaksanaan kegiatan pelatihan Corel Draw dan Autodesk Revit Building ini
dapat disimpulkan bahwa :
1. Kegiatan pelatihan Corel Draw dan Autodesk Revit Building dengan peserta PPA
Gergja ljen telah berjalan dengan lancar dan baik.
2. Peserta pelatihan sangat antusias terhadap materi yang diberikan oleh tim pelaksana.
3. Respon pengurus dan pembina PPA Gergja ljen sangat baik dan kooperatif, baik pada
saat sebelum pelaksanaan hinggan berakhirnya pel aksanaan.
4. Pengurus dan pembina PPA Gergja ljen menginginkan bahwa kegiatan tidak berkahir
pada pelaksanaan pelatihan, akan tetapi akan dilanjutkan pendampingan PPA Geregja
Ijen dalam mengimplementasi kan rencana kegiatan PPA di Gereja ljen khusunya untuk

mempublikasikan dokumentasi -dokumentasi kegiatan PPA Gergjaljen.

V.2 SARAN

Setelah pel aksanaan kegiatan pengabdian masyarakat untuk Putra Putri altar Gergjaljen
Malang, maka sangat perlu ditindak lanjuti dengan kegiatan pendampingan, sehingga dapat
membantu permasalahan nyata di |apangan.
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LAMPIRAN 1
SURAT PERNYATAAN MITRA

SURAT PERNYATAAN

KESEDIAAN BEKERJASAMA MITRA |

Yang bertandatangan di bawah ini kami :

Nama : Heribertus Heru Nurtjahjo

Jabatan : Pembina Putra Putri Altar Paroki St. Perawan Maria dari Gunung Karmel
Alamat : JI. Buring no. 60, Oro-oro Dowo, Klojen, Kota Malang

MENYATAKAN

Dengan sesungguhnya bahwa :

1. Saya bersedia bekerja sama dengan Tim Pengusul / Tim Pelaksana Program Kemitraan
Masyarakat Universitas Katolik Widya Karya Malang sebagai Mitra.

2. Segala hal yang berhubungan dengan pelaksanaan program akan diatur dalam perjanjian
kerjasama berikutnya.

Demikian surat pernyataan ini kami buat dengan sebenar-benarnya untuk dipergunakan
sebagaimana mestinya.

Malang, 28 November 2017

Heribertus Heru N.
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LAMPIRAN 4
DOKUMENTASI PELATIHAN

Gambar 1 Slide Pelatihan

Gambar 3 Pengarahan dari Pendamping dan Pembina PPA Gergjaljen Malang



—————

Gambar 5 otsama dengan peserta dan Pembi nPPA Gergjaljen

Gambar 6 Diskusi dan Evaluasi pelaksanaan Pelatihan
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BAB |
PENDAHULUAN

1.1 Pengertian Corel Draw

Corel Draw merupakan aplikasi yang berbasis vektor. Aplikasi grafis pada program
Corel Draw berfungsi secara khusus untuk membuat dan mengolah gambar yang
mempunyai format vektor. Gambar Vektor terdiri dari penggabungan koordinat-koordinat
titik berupa garis atau kurva untuk kemudian menjadi sebuah objek, sehingga gambar tidak
menjadi pecah walaupun diperbesar atau diperkecil. Gambar vektor umumnya memiliki

ukuran yang lebih kecil bila dibandingkan dengan gambar dengan tipe bitmap.

1.2 Pengenalan Interface
Untuk membuat file baru maka pilihan yang dipilih “New blank document”.
Pilihan menu tersebut akan menghantarkan pada workspace utama Corel Draw seperti

gambar berikut.

Tool B Lemb Drawi
|Too|box|||\/|enu Bar”TooI Barl P?gpert&;/r I?:rjsr era:]/gor\lfvg
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Gambar 1.1 Workspace Coerel Draw
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Keterangan:
a. Toolbox

Berisi pilihan tool dan mode menggambar. Klik pada sebuah icon tool untuk
menggunakannya, maka tombol icon akan tampak seperti ditekan, dan tool tersebut
siap kita gunakan pada bidang gambar. Kadang juga terdapat subtool yang dapat
dimunculkan dengan menekan agak lama pada sebuah icon tool, kemudian klik pada
sub tool yang tersedia.

Toolbox n

hfvr'l?.r-'utmé'ljuu A

565 E5605606666666

Gambar 1.2 Toolbox
Keterangan Tool

1. Pick Tool 7. Rectangle Tool 13. Interactive Blend Tool
2. Shape Tool 8. EllipsTool 14. Eyedropper Tool
3. Crop Tool 9. Polygon Tool 15. Outline
4. Zoom Tool 10. Basic Shapes 16. Fill
5. Freehand Tool 11. Text Tool 17. Interactive Fill Tool
6. Smart Fill Tool 12. Table Tool

b. Toolbar

Kumpulan icon yang berfungsi untuk mengakses menu-menu umum yang paling
sering dipakai.

c. Menu Bar
Kumpulan menu yang digunakan untuk mengakses seluruh fungsi-fungsi yang ada
pada Corel Draw, termasuk membuka — menyimpan file, efek-efek, dan sebagainya.

d. Tool Bar Property
Berfungsi menampilkan pilihan properti dari sebuah fungsi toolbox yang tengah
dipakai. Pada kondisi default (tool yang terpilih adalah pick tool (panah putih), maka
property bar akan berisi ukuran kertas bidang gambar, orientasi kertas, unit yang
digunakan, dan sebagainya. Property bar akan selalu berubah tergantung dari tool
yang kita pilih di toolbox.

e. Lembar Kerja
Areakerjayang merupakan printble area.

f. Drawing Window
Luasan bidang gambar dengan ukuran kertas tertentu yang dapat digunakan untuk
mendesain gambar. Apayang berada di luar tepi bidang gambar tidak akan ikut
tercetak saat dicetak.

I
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g. Ruler
Fungsi dari ruler bar adalah sebagai acuan ukuran dan posisi pada sebuah wor kspace.
h. Page Navigator
Berfungsi untuk membuat lembar kerja baru atau berpindah ke lembar kerjalain yang
ada dalam satu file.
i. StatusBar
Menunjukkan beberapa status penting dan event yang sedang terjadi, juga pada bagian
kanan menunjukkan warna fill dan line sebuah objek.
j. Color Palette
Digunakan untuk memilih warna yang akan kita pakai untuk mewarnai sebuah objek
gambar. Klik kiri pada palet akan mengeset warnaisian (fill) suatu objek, dan klik
kanan pada palet akan mengeset warnatepi dan garis (line).

1.3 Membuka File Corel Draw

Untuk membuka file Corel Draw atau membuka file yang pernah dissmpan dengan
menggunakan perintah Open file pada dialog “welcome toCorelDRAW” atau jika telah
memasuki system Corel Draw dapat melakukan dengan memilih Menu Bar File > Open.

Atau pilih langsung tool bar open.
il Upar Lirawing )

Gambar 1.3 Dialog Box “Open Drawing”

1.4 Menyimpan File
Setelah selesai menggambar dalam Corel DRAW file dapat kita simpan dengan pilihan
sebagai berikut
a Klik menuFile > Save atau
b. Klik icon save (document padatoolbar standart), atau
c. Tekantombol Ctrl + S
maka akan muncul save drawing dialog (kotak dialog save file) sebagai berikut:

I
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File name

Gambar 1.4 save drawing

Ketikan nama file yang kita buat.

File of type
Menentukan format file

1.5 Menutup Corel Draw

yang kita simpan. (Corel Draw berekstensi CDR)

Untuk mengakhiri program Corel Draw terdapat beberapa cara, sebagai berikut:

e Kilik pada Close button pada control window atau

e Klik menu File > Close

Jika kita lupa atau tidak ingin menyimpan file dan langsung menutup aplikasi Corel Draw

makaakan muncul dialog box yang menanyakan apakah dokumen akan disimpan atau tidak,

seperti berikut:

CorelDRAW

9 Save changes to Graphicl?

Gambar 1

Yes Mo Cancel

.5 Dialog save the change of document

I
ABDIMAS 2017/2018 - UKWK MALANG



BAB 11
MENGGAMBAR OBJEK GRAFISVEKTOR

2.1  Beberapa Jenislstilah Pada Corel Draw
Dalam pembuatan objek atau gambar grafik didalam Corel Draw terdapat beberapa jenis
istilah yang harus dikenali. Jenisistilah tersebut seperti gambar berikut ini:

~“Kurva terbuka \
e ) . Kurva tertutup

<—Qutline

Warna Fill ‘

Gradasi
Gambar 2.1 Beberapa jenisistilah pada Corel Draw
2.2  Toolbox Corel Draw
Pada toolbox terdiri dari alat/tool untuk melakukan berbagai perintah, bagian-bagian
toolbox antara lain:
a Pick toll (V) &
Untuk memilih, memanipulasi, dan mengontrol objek.
b. Shape Tool (F10)
Untuk memanipulasi objek/kurva
- - Shape, untuk mengedit suatu
outline/kurva.

k!
[3 Shape Tool (F10)

fy shape F10 " . Smudge Brush, untuk mengubah
; Q':;lﬁ‘:::r bagian garis outline pada objek dengan
%) Transform cara drag pada outline.

Gambar 2.2 Shape Tool - Roughen Brush, digunakan untuk

mengubah bagian outline pada garis vektor dari objek.
Tranform Tool, untuk memutar objek dengan bebas.
C. Crop Tool
Crop Tool, digunakan untuk menghapus objek diluar seleksi.
Knife Tool, berfungsi untuk memotong lurus maupun kurva pada objek
Erase Tool, berfungsi untuk menghapus bagian-bagian terntentu yang dari suatu
objek.
Virtual Segment delete tool, untuk menghapus segmen secara virtual.
d. Zoom Tool
Zoom Tool, membesarkan atau mengecilkan tampilan area kerja di monitor.

Hand Tool, menggeser area kerja ke posisi tertentu.
! ||
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e Freehand Tool

Bt | o s - Freehand, untuk menggambar kurva bentuk bebas.

‘o, Begier - Bezier , untuk menggambar kurva Bezier yang mempunyai
W AmistieMedia 1 handle untuk mengendalikan bentuk kurva.

: E:T}rline - Artistic Media, untuk menggambar kurva yang mempunyai
e 3Point Curve bentuk artitstic. Pen, sama seperti Bezier namun lebih

%, Connector fleksibel.
el i - Polyline, sama seperti Bezier Tool dan Pen Tool.

3 Point Curve, membuat kurva terbuka lengkung yang presisi.

Connector, untuk membuat konektor antar objek

Dimension, membuat keterangan dimensi objek

f. Smart Tool

Smart Fill, untuk mewarna objek dan garis secara bersamaan sesuai dengan
pengaturan.

Smart Drawing (Shift+F5), membuat obyek garis secara bebas seperti freehand
tool, namun dengan hasil yang |ebih bagus.

0. Rectangle Tool
- Rectangle, untuk membuat bentuk kotak
el |- HECtEmEte Fo . 3Point Rectangle, untuk membuat bentuk kotak yang
:_[ 3 Point Rectangle berawal dari satu sisi.

Tips: untuk membuat bentuk samasisi yang presisi, tekan Ctr| dan untuk membuat dari titik
tengah tekan Ctrl+Shift.
h. Ellipse Tool

- Ellipse, untuk membuat lingkaran

(0 Ellipse F7 - 3 Point Ellipse, untuk membuat bentuk lingkaran
a=o 3 Point Ellipse yang berawal dari satu sis
i. Polygon Tool
- Polygon, untuk membuat gambar segi banyak
_»| Polygon Y - Star, untuk membentuk bintang
3 | Star - Complex Star, untuk membuat bintang dengan sisi
1¥ ComplexStar menyilang
41 Graph Paper g - Graph Paper, untuk membuat kotak yang terbagi dari
- beberapa grid
©; Spiral A

| - Spiral, untuk membuat spiral
Tips: untuk membuat bentuk samasisi yang presisi, tekan Ctr| dan untuk membuat dari titik
tengah tekan Ctrl+Shift.
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J- Basic Shapes
. Tool-tool yang berguna untuk membuat objek-objek
1) Basic Shapes primitifpada umumnya atau objek dasar.
|f=  Arrow Shapes
5 Flowchart Shapes
1

Banner Shapes

]

Callout Shapes

K. Text Tool [\ (F8)
' il » Text Tool, berfungsi untuk mengetik suatu teks

et s et nis nna:I.Jm sagms Nulia In turpis Nulla interdum 1 atau par agraph

!eo quis felis. Suspendisse metus mauris, consequat omare, | )

pliquet sed, egestas et, odio. Curabitur fringilla. Donec quisuma § T 1 ps:

In quam suscipit pretium, Vestibulum nonummy augue imperdiet

fpsum. Cras congue, pede sed euismod ullamcorper, odio pede | Untuk membuat text frame/ par agraph, tekan Text

pla grat justo, sed tempor orci velit a ante, Phasellus dignissim i

emm Cras pharetra ullamcorper quam, Vivamus consectetuer : Tool (F8) lalu drag area yang dibutuhkan untuk
W magna id magna. Danec fermeriim, diam sed molestie pharetra, "

;nam nisl gravida velit id semper dui massa sit amet sapien. | menampung teks, sama Sepem membuat gambar
Mauris dui. :
' kotak/rectangle.

! i
Nam feugiat. Nam eleifend, diam ac convallis honcus, lacus nibh
ibendum purus, id porta leo &lit sodales dolor, Ut dui risus
convallis at, fringilla at, elementum quis, felis. Fusce quis urna
f_‘:larn fingilla sapien sit amet nisl. Ut pulvinar nibh at mauris.
Donec elit, | "

Gambar 2.4 Text Tool

. TableTool
Berfungsi untuk membuat table yang dapat diis teks/data.

m. I nteractive Blend Tool
o Interactive Blend Tool, berfungsi untuk membuat peralihan
Contour dari satu bentuk objek ke bentuk objek yang lain. Bentuk kedua
Distort objek akan bercampur manjadi satu.

Drop Shadow ) )
I nteractive Contour Tool, berfungsi untuk

M@ XD Gﬁﬁ?

Envelope
Extrude memperbesar/memperkecil ukuran suatu objek.
Transparency - Interactive Distrot Tool, sangat bermanfaat untuk ‘merusak’

bentuk suatu objek sehingga menghasilkan bentuk objek lain yang berbeda.
I nteractive Drop Shadow Tool, untuk menambahkan efek bayangan di bawah satu
objek.
Envelope Tool, untuk membentuk suatu objek seolah-olah objek tersebut
terbungkus oleh suatu bentuk.
Extrude Tool, untuk memberi efek 3 dimensi dari objek 2 dimensi.
Transparency Tool, memberikan efek transparan pada suatu objek.
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n. Eyedropper Tool X

Eyedropper Tool, untuk mengambil warna dari suatu objek.
Paintbucket Tool, mengisi warna ke suatu objek

0. Outline
Outline Pen... Fi1z
& oOutline Colar...  shift+F12

&

0

X Mone
% Hairline
— 1jzpt
— 1lpt
— 7 pt
== Sk
= ep
B 4pt

Calar

Outline Pen @
il i

Celer: -|vj e

wilthe —:v] — v'

[ozm3pt [a] [points ]

Laharachy
Strecch: MIE shape:

Euil Syl AT ENSY

iter Limit: = [ ©
[iter Limit: 5N e aralke .
]2
U

Corners Lin= caps

C A = Defall
O A Q) ==

= = [~ Tes=hind fil

(ol 0 =n

Szzle with image
O =

[ UE; ] [ Cancel Help

Gambar 2.5 Eyedropper Tool

Outline Pen akan menampilkan kotak dialog Outline Pen seperti gambar di bawah.
Outline Color akan menampilkan kotak dialog Color.

QCutline style normal, ketehalan 0.567 point

-

—
T
B 8 "

— —

Qutline style normal, ketebalan 2 point, arrowed

%

Gambar 2.6 Outline

Unifarm Fill,..  Shift+F11
Fountain Fill,.. Fi1
Pattern Fill,..
Texture Fil...

PostScript Fill. ..

Mone

Color

PENTING:
Selalu gunakan warna CMY K
Penggunaan mode warna RGB

Uniform Fill, untuk mengisi warnafill / blok warna
pada suatu kurva tertutup.

Fountain Fill, untuk mengisi fill warnagradasi.

Pattern Fill, utnuk memberikan patter atau pola.

Texture Fill, untuk mengisi tekstur pada suatu objek.

PostScript Fill, untuk memberikan efek postscript.

None, menghilangkan fill pada suatu objek.

jika hasil gambar akan dicetak atau dikirim ke percetakan.
hanya untuk menampilkan gambar di display monitor sgja.
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[ Fountain Fill a
-tinrs
reser g o]
Canka- cffzet L 03[
v el 0 3w
ar b
= e vuston
Frzi [ u 4
W = (sl -
ey o 2
Frose: [v] [F=
[ e [ ot |[ b |
[ edd lol'dezz ][: _ Gpthns = ] 3 [ onezd ] [ Helz |

Gambar 2.7 UniformFill
g. Interactive Fill Tool (G)

@ Interactive Fill G
Interactive Fill, salah satu kelebihan Corel

Draw adalah ada banyak cara untuk mengisi warna pada suatu objek kurva tertutup. Dengan
tool ini pengisian warna tidak harus dengan cara seperti di atas karena bersifat interaktif
artinya user dapat langsung mengendalikan proses pewarnaan & melihat hasilnya.

2.3  Perataan Objek Terhadap Objek Lain

Dalam pengaturan objek, objek dapat diatur dengan perataan objek agar terlihat rapi.
Perataan atau alignment biasanya terjadi jika kita menggunakan satu objek sebagai tolak
ukur perataan dari objek yang lain.

Perataan ObJ ek terdl ri darl : rlklign and Distribute

Rata Kanan (R) | Align LQi__s_F_r_i_‘?_E'_te'
Rata Kiri (L ) E| Left F C?nlter F Rigl;_t‘
Rata secara datar Horisontal (C) | 1 Oroe Align Objects To: l

. | Active objects |2
Rata secara datar Vertikal (E) e [ Conter :

For Text Source Objects Use:
Ra-ta- Ata.S (T) 1l [Jeattom ré;;n_dlng bz ! !vi
Rata Bawah (B)
[ Apply ] [ Close

24  Membentuk Ulang Objek Gambar 2.9 Align and Distribute

Dalam membentuk objek yang dikehendaki terkadang memerlukan perlakuan untuk
dilakukan pembentukan ulang atau melakukan editing. Di program Corel Draw dapat
membentuk ulang atau melakukan editing objek-objek yang sudah ada dengan cara:

- B [h o Gy 5 B G
Gambar 2.9 Editing Objek

Weld (mengelas/menyambung objek) &

I
ABDIMAS 2017/2018 - UKWK MALANG



10

Trim (memotong mengikuti bentuk objek pemotong)
|]..

I nter sect (mendapatkan gambar perpotongannya)

Simplify (gambar tumpukan teratas memotong gambar di bawahnya)

Front Minus Back dan Back Minus Front

a Membuat objek baru berdasarkan outline gabungan dari kedua buah objek.

2.5  Efek Khusus
Corel Draw menyediakan beberapa efek khusus, antaralain:
2.5.1 Perspective
Efek Perspective disebut juga dengan sudut pandang, jika menggunakan efek ini kita dapat
mengatur objek agar terlihat dari sudut tertentu. Misalnya kita akan memberi efek
Per spective pada sebuah teks, caranya adalah sebagai berikut:
1. Ketik teks Perspectif menggunakan Text Tool.
2. Klik menu Effects dan klik Add Per spective, maka pada teks tersebut akan muncul
garis bantu merah dan di setiap sudut teks akan terdapat titik Perspektifnya.
3. Tunjuk salah satu titik perspekstifnya dan tarik sesuai dengan keinginan kita,
seperti terlihat pada gambar berikut ini:

Gambar 2.11 Efek Perspective

2.5.2 Blend
Efek Blend digunakan untuk mengubah suatu bentuk objek ke bentuk objek yang lainnya.
Untuk memakai efek ini, gunakanlah Interactive Blend Tool yang berada pada kumpulan
Tool Box. langkah-langkah penggunaan blend sebagai berikut:

1. Buat sebuah lingkarang besar kemudian beri warna kuning dan buat kotak kecil

dengan warnabiru.

2. Aktifkan I nteractive Blend Tool
Klik pada lingkaran, mouse sambil ditahan tarik ke arah kotak.
4. Lepaskan penekanan mouse jika pointer sudah sampai pada objek kotak, maka

akan terjadi proses perubahan.

w

I
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Gambar 2.12 Efek Blend
Pada saat efek Blend ini aktif, kita bisa melakukan beberapa proses lain yang disediakan
pada Property Bar, diantaranya:
Direct Blend, untuk memakai warna objek asal dan objek tujuan secara langsung
Clockwise Blend, untuk memakai warna objek asal dan objek tujuan dengan memakai
warna seluruh searah jarum jam.
Counter clockwise Blend, untuk memakai warna objek asal dan objek tujuan dengan
memakai warna yang berlawanan arah jarum jam.
Path Properties, untuk ini digunakan agar perubahan bentuk objek tersebut mengikuiti
garis bantu.
Clear Blend, untuk menghapus efek Interactive Blend Tool

2.5.3 Extrude

Efek lain adal ah Exstrude, yaitu efek yang digunakan untuk membuat objek menjadi tampak

seperti 3 dimensi. Efek ini berpengaruh terhadap teks atau selain teks.

Misalnya kitamempunyai teks EXSTRUDE yang akan diberi efek Exstrude, maka langkah-

langkahnya adalah sebagai berikuit:

1. Kaetik teks EXTRUDE, dengan huruf Arial Black ukuran 80 point, beri warna putih
dengan outline warna hitam.

2. Aktifkan I nteractive Exstrude Tool

3. Klik satu kali pada teks tersebut, drag mouse ke arah mana objek tersebut akan dibuat
dimensinya.

4. Lepaskan penekana mouse jika bentuk objek tersebut sudah sesuai.

Gambar 2.13 Efek Extrude

2.5.4 Contour

Efek Countour digunakan untuk memperbanyak atau menyalin objek dengan ukuran yang
berbeda-beda, dalam memperbanyak objek tersebut, kitabisamemilih arah salinan objeknya
ke tengah-tengah (To Center), ke dalam (Inside) atau keluar (Outside).

I
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Misalnya kita mempunyai teks CONTOUR yang akan diberi efek Countour, maka
langkahnya adalah sebagai berikut:

1. Kaetik teks CONTOUR, dengan jenis huruf Arial Black, ukuran 80 pt dan beri warna
putih dengan outline hitam.

Aktifkan I nteractive Contour Tool

Klik pada pilihan Outside, supaya teks yang diperbanyak mengarah ke luar.

Pada pilihan Counter Step is dengan nilai 5

Pada pilihan Counter Offset isi dengan nilai 0.06, maka akan dihasilkan teks.

o DN

Gambar 2.14 Efek Contour

2.5.5 Power Clip

Efek Power Clip digunakan untuk menetapkan objek di tengah-tengah objek lain. Misalnya

kita mempunyai teks POWER CLIP yang akan dimasukkan ke dalam lingkaran, maka

langkah-langkahnya adalah sebagai berikut:

1. Ketik teks Power Clip dengan jenis huruf Arial, dan ukuran 80 point

2. Buat lingkaran dengan menggunakan Ellipse Tool

3. Aktifkan tekstadi dengan Pick Tool, lalu klik menu Effects kemudian pilih menu
Power Clip dan klik pada pilihan Place Inside Container, maka pointer akan berubah
menjadi anak panah menghadap ke kanan.

4. Bawapointer ke arah lingkaran, klik satu kali jika sudah sampai pada daerah
lingkaran, maka teks tadi akan dimasukkan ke dalam lingkaran.

TR
/ \\
<POWER CLIP
\ //

Gambar 2.15 Efek Power Clip
Objek yang dimasukkan ke objek lain dengan menggunakan efek Power Clips, akan di
tempatkan di tengah-tengah objeknya. Untuk mengatur posisi objek supayatidak berada di
tengah-tengah, klik menu Effects lalu pilih menu Power Clips kemudian klik pilihan Edit
Contents, maka objek yang dimasukkan tadi akan terpisah kembali, dan kita dapat mengatur
ulang posisi objek tersebut sesuai dengan keinginan kita, jikasudah selesai klik menu Effects
lalu pilih menu Power Clips kemudian klik pada pilihan Finish Editing This Level.
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2.5.6 Shadow

Efek Shadow atau bayangan akan memberikan kesan menarik terhadap objek yang telah

dibentuk.

Misalnya kita mempunyai teks yang akan di beri efek Shadow, maka langkah dalam

pembuatannya adalah sebagai berikut:

1.  Kaetik teks Shadow dengan jenis huruf Arial Black dan ukuran 100 point.

2. Aktifkan Interactive Drop Shadow

3. Jkapilihan ini tidak tampil, klik sambil ditahan pada pilihan Toll Interactive dalam
Tool Box.

4.  Bawapointer ke teks tadi kemudian klik satu kali, sambil ditahan tarik pointer ke arah
mana bayangan tersebut akan disimpan.

Gambar 2.16 Efek Shadow

2.5.7 Distortion
Efek Distrotion akan menyebabkan perubahan pada objek terpilih seperti terkena tiupan,
untuk menggunakannya, kita memakai alat yang dinamakan | nteractive Distortion Tool.

G N

N

Gambar 2.17 Efek Distortion
Pada saat Interactive Distortion Tool ini aktif, kita menggunakan tiga efek pilihan yang
disediakan dalam Property Bar, diantaranya:
Push and Full Distortion
Pilihan ini akan mengakibatkan perubahan terhadap objek terpilih seperti terkena
dorongan atau tarikan. Misalnya buatlah sebuah kotak dan diberi efek ini.
Zipper Distortion
PFilihan ini akan mengakibatkan perubahan objek terpilih seperti tertarik ke suatu sisi
tertentu.
Twister Distortion
Pilihan ini akan mengakibatkan objek yang terpilih seperti kena tiupan angin yang
kencang.

I
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BAB |11
KREATIF PROJEK

Pada Bab ini, setelah memaha dasar-dasar Corel Draw maka perlu untuk dicoba dalam
projek-projek sederhana seperti berikut:
3. 1 Pembuatan Cap Stempel Sederhana

a. Buat new file pada Corel Draw

Gambar 3.1 Icon New File
b. Buat lingkaran simetris dengan cara klik elipse tool — tekan dan tahan tombol

“control (Ctrl)” — klik, tahan, dan geser kursor pada drawing windows hingga
muncul sebuah lingkaran simetris.

Gambar 3.2 Lingkaran simetris
c. Ulangi langkah sebelumnya hingga terdapat dua buah lingkaran simetris. Kemudian
salah satu lingkaran diubah ukurannya hingga tampak seperti pada gambar 3.3 :
d. Blok seluruh lingkaran dengan klik dan tahan kursor kemudian di kelilingkan ke
seluruh lingkaran. Setelah ter blok maka di property bar akan muncul merging tool,
klik yang bagian “back minus front™.

._./ - ., . I DID : .
S \__\
- - [h Oy B Gy By B O =
| * "
l\ | ;:I II 3 10 1

9
/ -'---'---!.---'-:|Bacl‘:h'1inu5Fr-:ntl_--'

Gambar 3.3 Merging Dua Objek

. _____________________|]
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e. Buat sebuah persegi panjang di area dua lingkaran tersebut.

Gambar 3.4 Rectangle Tengah Lingkaran
Setelah itu blok kembali keseluruhan objek dan di merging kembali dengan pilihan
“weld” hingga bentuk objek menjadi seperti gambar dibawah ini :

i S
WL :’ |
i e [ uu - e
0y 0 O Gy b By O
Gambar 3.5 Welding Objek
f. Klik Text Tool, kemudian klik di drawing window. Ketik katayang ingin di masukan

ke dalam cap stempel.

0. Setelah semua kata sudah dibuat, masukan kata-kata tersebut ke dalam objek yang
sudah dibuat. Agar dapat mengikuti bentuk dari objek maka gunakan “fit to the path”
text, caranyaklik text yang akan dimasukan, kemudian klik menu TEXT pada menu
bar, pilih “fit to the path”. Posisikan teks hingga sesuai dengan rancangan dan
keinginan.

Gambar 3.6 Hasil Desain Stempel

L]
ABDIMAS 2017/2018 - UKWK MALANG



16

3.2 Pembuatan Cover dan Text pada Lembar Layout
a  Membuat Cover Buku
1. Bukalembar baru dengan ukuran kertas A4 — Potrait
2. Buat pola Cover, contoh seperti gambar layout dibawah:

(
(P
4
%

Gambar 3.7 Pola Cover

3. Berikan text dengan “Text tool”, untuk memberikan isi sebagai header text
dan keterangan-keterangan yang lain, sehingga informas awal sebuah cover
dapat menarik. Serta berikan warna pada pola yang telah dibuat, contoh
seperti gambar berikut:

& SEUGRUPANTIALANS

Gambar 3.8 Pemberian Text pada Pola Cover

I
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4. Insert gambar atau mengambil gambar dari file-file dengan tipe gambar.
Kemudian memasukkan gambar pada pola cover dengan menggunakan
menu; Object - PowerClip = Place Insert Frame, sehingga cover akan
lebih menarik.

& KEUSKUPAMN MALANG
W GERSIAST WARWONR GLIIRG SARMWEL

Gambar 3.9 Desain Cover

b. Menempatkan dan Mengatur Text pada Layout
Untuk meletakkan text pada layout yang telah dibuatkan pola atau desainnya,
lebih mudah jika text telah disigpkan dalam file lain yaitu Microsoft word.
Bukalah file dari Microsoft word tersebut, makatinggal di copy seluruh text yang
akan dimasukkan ke dalam layout.

P Cick herswit Tot Tool to odd Pacgraph bt |

| Click bere wits Tt Tod! 'o ool Poragroph o | |

Gambar 3.10 Layout Text

I
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3. 3 Pembuatan Gr afis Foto

Gambar 3.11 Grafis

3. 4 Pembuatan L ogo Sony Ericsson

SOond er ICsSs0n
Gambar 3.12 Logo Sony Ericsson

I
ABDIMAS 2017/2018 - UKWK MALANG



MODUL

Autodek REVIT

PEMATERI:
Benedictus Sonny Yoedono, SPd., M.T. NIDN : 0720038001



A.  DEFINISI DAN KONSEP

= Autodesk Revit adalah sebuah aplikasi untuk mempermudah merancang dan menggambar gedung

= Revit menggunakan konsep BIM (Building Information Modelling) ,secara ringkas BIM dapat diartikan
membuat dan menggunakan model virtual bangunan. Sama seperti halnya jika membangun bangunan
yang sesungguhnya, hal yang sama juga dilakukkan di Revit.

= Revit merupakan program Parametric Change Engine, terdapat keterikatan antara components, view,
annotations

B.  USER INTERFACE

Standart Menu Bar  Design Options
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C.  PROJECT UNITS

= Untuk mengakses aturan pemilihan tipe unit, Standard Menu Bar>Setting>Project Unit
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D.  LATIHAN SOAL
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1. Pilih Setting> Project Unit (UN)> millimeter

2. Membuat Dinding. Pilih Design Bar> Basic> Wall> Basic Wall: Generic — 200 mm, centang Chain. Buat
dinding pinggir
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4. Membuat Lantai, Pilih Design Bar>Basic> Floor> Pick Walls = Offset = 900 mm, Centang Extend into
wall, pilih dinding sebelah luar, edit dengan Trim, jika telah sesuai pilih Finish Sketch



Memberikan Dimensi, Pilih Design Bar> Basic> Dimension
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Memberikan Teks, Pilih Design Bar> Basic> Text

Memberikan Pintu dan Jendela, Pilih Design Bar> Basic

a. Untuk pintu R. Tamu, R. Tidur, dan Dapur pilih (Load) : M_Single Panel 1: 0915 x 2134 mm

b. Untuk pintu WC pilih (Type selector) : M_Single Flush : 0762 x 2134 mm

c. Untuk jendela R. Tamu dan Dapur pilih (Load) : SA_Window-Double Shutter : 1500 x 1500 mm
d. Untuk jendela R. Tidur pilih (Load) : SA_Window-Single Shutter : 750 x 1500 mm
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Samakan elevasi/ ketinggian pintu dan jendela dengan menu Align, Wireframe, pada view South, East,
West, North

Membuat Level, pada elevasi North, pilih Design Bar> Basic> Level, kemudian buat garis dari kiri ke
kanan, dan edit tinggi dan namanya bila perlu

Atap ﬂ
3300

Lantai ‘i
T 0 \.\-\-



10.

11.

12,

13.

14.

15.

Membuat Atap

a. Pilih Elevation Floor Plans> Atap (elevasi untuk membuat atap)

b. Design Bar> Basic> Roof> Roof by footprint

c. Buat sketsa garis atap yang diinginkan, dengan sudut 35°, Finish Roof
d. Pilih jenis atap : Basic Roof : Generic — 125 mm

Membuat Plafon

a. Pilih Elevation> Ceilling Plans> Lantai

b. Modelling> Ceilling> Sketch

c. Ceilling Properties> pilih Constraints> Level = Lantai> Height offset from level = 2600 mm
d. Pilih Auto Ceilling, finish sketch, cek tampilan

e. Buat Plafon untuk selasar dengan Pick Walls dan Offset, Trim, Finish Sketch

Membuat Lisplank

a. Pilih Elevation> Floor Plans> Atap

b. Modelling> Host Sweep>Roof Fascia

c. Pilih pinggir atap yang akan diberikan lisplank

Membuat Gambar Potongan

a. Pilih Elevation> Floor Plans> Lantai

b. Basic> Section

c. Buat Potongan sesuai dengan yang diinginkan

Memberikan Nama Ruang berdasarkan Area menggunakan Room Tag
a. Elevation> Floor Plans>Lantai

b. Design Bar> Basic> Room Tag

c. Letakkan Room Tag di ruang/area

d. Ganti Nama Ruang sesuai dengan yang diinginkan

Membuat Schedule/ Quantities

a. Elevation> Floor Plans>Lantai

b. Design Bar> View> Schedule/Quantities
c. Pada Tab New Schedule pilih Rooms



d. Pada Schedule Properties Dialog Box pilih Tab Fields
e. Pada Available Fields pilih Number, Name, Area, Level
f. Mengatur Tampilan Header Tabel, pilih Tab Appearance, pada Header Text pilih Bold

16.

Room Sn:h&dule{
Number Hame Lewel Area
9 R. Tidur Lantai & me
10 R. Tamu Lantai 15 m®
11 WC Lantai 2m
12 R. Tidur Lantai & me

Memberikan Material Finishing pada Elemen Bangunan

a. Material finishing untuk Dinding Exterior
- Tampilan 3D View
- Design Bar>Basic> Wall
- Pada Option Bar, pilih Properties
- Pada piilhan Type, pilih Edit/new,
- Pilih Duplicate, pada Type Parameter>Structure, pilih Edit
- Pada Tab Material Layer, pilih By Category
- Kemudian Pilih Masonry-Brick> Duplicate>
- Klik di tanda panah Accurender>Texture, pilih Brick, Carib, 200 mm, Running
- lJika ingin diberikan warna, caranya sama
b. Material finishing untuk Atap, sama dengan Dinding
. Meletakkan Camera
a. Elevation> Floor Plans>Lantai
b. Design Bar>View> Camera
. Memberikan Site
a. Elevation> Floor Plans>Site
b. Design Bar> Site> Toposurface
c. Elevation=-150
d. Buat Site dengan point
. Rendering
a. Elevation>3D View dengan Camera
b. Rendering>Raytrace>Exterior
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